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1 Introduction 

This document is a user’s manual for the SPIRE TFTS User Interface (TFTS-UI).  
The TFTS-UI is an IDL application that serves as the front end to the TFTS 
System, where the TFTS System is comprised of the TFTS Communications 
Server as well as the TFTS hardware.  The TFTS-UI is to be used to initialise, 
verify and operate the TFTS System in preparation for the SPIRE Cryogenic 
Qualification Model Instrument Level Test (CQM-ILT) at RAL. 
 
In order to ensure that the TFTS System is reliable before the CQM-ILT, it is 
necessary for it to be tested in an environment similar to that that will be present 
during the CQM-ILT.  The TFTS-UI was designed with this principle in mind.  The 
TFTS-UI does not issue commands directly to the TFTS System rather, the 
EGSE Router (AD04§1.4.4.1) serves as an intermediary as shown in Figure 1.  
Furthermore, the format of the commands issued by the TFTS-UI is identical to 
that that SCOS (AD05) will issue during the CQM-ILT.   

Figure 1 TFTS Software components  

1.1 Scope 
This purpose of this document is to serve as a guide to the TFTS-UI and how it 
may be used to test, verify and operate the TFTS System.  This document does 
not describe the details of the communication between the TFTS-UI and the 
TFTS System.  For those details refer to AD01. 

1.2 Structure of the Document 
Section 1.4 of this document presents the requirements for the TFTS User 
Interface.  The procedure on how to load and run the TFTS-UI application as well 
as the steps necessary to initialise the TFTS-UI is presented in Section 2.  
Section 3 describes the procedure for verification of the TFTS System.  Section 4 
describes how to use the TFTS User Interface to control the TFTS System during 
normal operation.  The various exceptions and how one may recover from them 
are presented in Section 5.  Finally, Section 6 describes in detail the elements of 
the TFTS User Interface GUI and their functionality. 

EGSE 
Router

TFTS System User 
Interface 

TC 

TM TM 

TC 
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1.3 Documents 

1.3.1 Applicable Documents 
AD01 SPIRE Technical Note – Canadian Contribution -- Software 

(SPIRE-UoL-NOT-001554), Version 1.0 
AD02 SPIRE TFTS Communications Server, User Guide 

(To be Written) 
AD03 SPIRE Test Facility FTS Data ICD 

SPIRE-UoL-PRJ-001452 
AD04 HCSS Test Report 

HSC/REP/0314, Issue 1.3 
AD05 EGSE BASED ON SCOS 2000 

TOS-EMG/01-1029/bm/sv 

1.3.2 Reference Documents 
RD01 HCSS Software Verification and Validation Plan 

(HERSCHEL/HSC/DOC/0284), Issue 1, Revision 1 
RD02 Unidex 500 User’s Manual 

1.4 System Requirements 
In order to test, verify and operate the TFTS system with the TFTS User 
interface, the following components are required: 
 
• IDL 5.6 or higher 
• TFTS Communications Server (AD02) 
• EGSE Router (AD04) 
• A Signal Detection and Display System 
 
The SPIRE TFTS User Interface is a software application written in the IDL 
programming language.  Thus, the host machine on which the TFTS-UI is to be 
run must have an IDL license.  Additionally, the TFTS-UI will only run properly on 
a system with IDL version 5.6 or later.  Instructions on how to initialise and 
execute the TFTS User Interface are presented in the next section.   
 
The set-up and execution procedure for the TFTS System may be found in AD02 
while that for the EGSE Router may be found in AD04.  Note that one must start 
the EGSE Router before initialising either the User Interface or the TFTS System. 
 
The signal detection and display system should consist of an infrared detector 
(Cryo-cooled ∆Σ detector or a Golay Cell) and an instrument to display the 
electrical signal from the detector in real-time (e.g. an oscilloscope).  
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2 Initialisation 

The following sections describe how to load, start and initialise the SPIRE TFTS 
User Interface.   The initialisation procedure assumes that the EGSE Router is 
running and listening for new connections on a host machine to which the TFTS-
UI has access.  
 
The procedure to load the SPIRE TFTS User Interface is as follows. 
 
1. Start an IDL session.  On Windows systems double-click the IDL icon on the 

desktop or select Start→Programs→Research Systems IDL 5.6→IDL.  For a Unix 
system, load the IDL Development Environment by typing the command 
`idlde`.  

  Figure 2 The User Interface Project 

2. Load the User Interface source code into IDL.  Load the source files, 
definition files and bitmaps required by the User Interface application into IDL 
by selecting SPIRE_vt.prj project file via File→Open Project…  You may 
need to contact your local system administrator to find the location of the 
SPIRE_vt.prj project file on your local system. 

3. Compile the User Interface source code.  Select Project→Compile→All 
Files to compile the TFTS-UI source code (see Figure 2).   
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4. Start the User Interface application. Select Project→Run to start the TFTS-

UI application. 
 
At start-up, the user should see the TFTS User Interface GUI as shown in 
Figure 3. 

 
 

Figure 3 Initialisation Tab 

 
5. Connect to the Router. A connection between the User Interface and the 

EGSE Router must be established in order to send commands to the TFTS 
System.  The Initialisation Tab on the User Interface contains data entry fields 
that allow the user to select the host on which the  EGSE Router is running 
(see Figure 3). 

 
Select the host machine on which the EGSE Router is running by choosing a 
host name from the drop-down menu.  This will update the IP and Port data 
fields with values linked to that host name.  If the desired host does not 
appear in the drop-down list, edit the Host Name, IP and Port parameters so 
that they contain appropriate values.  These parameters may then be stored 
for future use by selecting the Store Router button. 
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Once the appropriate IP and Port values are displayed, select the Connect 
button to try to establish a connection with the EGSE Router.  If this attempt is 
successful, the focus of the User Interface will switch to the Troubleshooting 
and Verification Tab (§Figure 4) and the elements of the Initialisation Tab will 
be de-sensitised.  If the attempt to establish a connection is unsuccessful, the 
User Interface will generate an exception message (§5.1.6). 
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3 Verification 

As mentioned in §2, once the connection the EGSE Router has been 
established, the focus of the User Interface will automatically switch to the 
Troubleshooting and Verification Tab (see Figure 4).  The elements on this tab 
allow the user to find and/or verify the position of zero path difference of the 
TFTS stage.  The elements on this tab are also useful for sending commands to 
the TFTS System that enable it to recover from errors. 

Figure 4 Troubleshooting and Verification Tab 

 
 
1. Connect Test.  Select the Connect Test button on the Troubleshooting and 

Verification Tab to test whether there is a valid connection between the TFTS 

Status 
Panel 

Reset 
Panel 

Jog 
Panel 
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User Interface and the TFTS System (via the EGSE Router).  If the TFTS 
User Interface does not receive a response from the TFTS System within 
three (3) seconds, a ‘Handshake TIMEOUT’ message will appear in the TFTS 
Status field (§5.1.3).  This situation may be remedied by re-starting the TFTS 
Communications Server.  If this problem persists, contact your system 
administrator 

     
2. Reset the TFTS. The next step in the verification process is to reset the 

TFTS Software and Hardware by choosing the Reset button (see Figure 4).  
This is recommended not only at start-up but should also be performed 
whenever the TFTS System reconnects with the EGSE Router or when the 
TFTS System is in and ERROR or ABORT state (§6.2).   

 
The TFTS may be reset by choosing one of the three options in the Reset 
Panel of the Troubleshooting and Verification Tab (see Figure 4).  The three 
TFTS reset options and their effect on the TFTS System is presented in Table 
1. 

 
Reset Panel Button Reset Functions Executed 
Reset 1, 2, 3 
Home 2, 3 
Go 3 

Table 1 TFTS Reset Levels 

1. Reset the Unidex 500 card 
2. Find the stage to the calibration position 
3. Move the stage to a specific position 

 
Use the associated drop-down menu in the Reset panel to specify the 
position to where the stage is to be moved (see Figure 4). 

 
NB Currently, only the TOP of the table may be selected as a final destination 
of a reset function.  

 
3. Locate the Position of Zero Path Difference. In order to locate the position 

of zero path difference, there must be a mechanism in place to detect and 
display the output of the TFTS System (i.e. a detector).  

 
Move the Stage to the ZPD position 
Use the unidirectional Jog buttons (see Figure 4, Jog panel) to move the 
stage to the ZPD position.  The stage position where ZPD is expected to be is 
displayed in the status panel of the TFTS-UI. 
 
Scan about the ZPD position 



 

Spire User Interface 
User’s Manual 

Issue 1.0 

15 August 2003 

Page 10 of 22 

  
To command the stage to move continuously back and forth (up and down), 
select the bi-directional arrow button in the Jog panel of the Troubleshooting 
tab (see Figure 4).  For this mode, the distance data field in the Jog panel 
represents the amplitude of the movement about the starting stage position.  
Observe the detector signal as the stage moves about the ZPD position.   
 
Once bi-directional stage movement has begun, the TFTS stage will continue 
moving in this manner indefinitely.  The user must select the HALT button to 
discontinue bi-directional stage movement.  

 
4. Save the ZPD Value. When the ZPD position of the TFTS System has been 

located, move the TFTS stage to that position.  Once the stage is at the ZPD 
position, store the ZPD value by selecting the Store ZPD button.  
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4 Normal Operation 

To execute a scan with the TFTS System, select the Operations Tab.  Scan 
parameters may be specified using the data entry fields in Operations Panel as 
shown in Figure 5.  To initiate a scan, select the SCAN button.  Note that a scan 
should only be initiated after the ZPD position has been verified (§3) and only if 
the TFTS System is in the IDLE state (see Table 4). 

Figure 5 Operations Tab  

 
During a scan, additional status information is provided in the Operations panel 
(see Figure 5).  This additional information consists of the current scan iteration, 
the total number of scans requested, the estimated time to complete the scan 
sequence and the absolute positions of the scan endpoints.  These parameters 
are updated once per second from the information provided by the TFTS 
Housekeeping telemetry. 
 

Status 
Panel 

Operations 
Panel 
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To terminate a scan sequence prematurely, one may select either the Halt button 
or the Truncate button (see Figure 5).  The Halt function terminates the scan 
sequence immediately, and causes the TFTS System to enter the ABORT state.  
The Truncate function terminates the scan sequence at the end of the current 
scan, then returns the TFTS to the IDLE state.  Issuing the Truncate command 
when the stage is not scanning has no effect on the TFTS System. 
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5 Exceptions 

5.1.1 Bad Parameter 
The User Interface contains many different data 
entry fields.  These fields allow the user to specify 
values for various TFTS parameters.  Each of 
these parameters has a range of acceptable 
values (see AD03 for details).  If the operator 
attempts to submit a value for a parameter 
outside its range, the User Interface will display 
one of the error messages shown in Figure 6.  
 
NB Selecting ‘OK’ acknowledges the exception, 
but does not correct it. 

Figure 6 Bad Parameter 
Exceptions  

5.1.2 TFTS Busy 
If the user attempts to send a telecommand while 
the TFTS System is executing a function, a TFTS 
Busy exception message is generated (see 
Figure 7).  This message indicates that the TFTS 
System could not execute the most recent 
command and that the command should be re-
sent.  Choosing ‘OK’ acknowledges the 
exception. Figure 7 TFTS Busy 

Exception 

5.1.3 Timeout Exceptions 
The User Interface maintains two software timers that are used to monitor the 
status of the TFTS System automatically.  These are the Heartbeat timer and the 
Handshaking timer.  
 
Heartbeat Exception 
The TFTS-UI Heartbeat timer checks whether housekeeping telemetry is still 
being received from the TFTS System.  The TFTS-UI is supposed to receive 
housekeeping telemetry from the TFTS once per second.  If the TFTS-UI does 
not receive telemetry for ten (10) consecutive seconds, the message “Heartbeart 
TIMEOUT” will appear in the TFTS Status field. 
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Handshaking Exception 
The TFTS-UI Handshaking timer monitors the receipt of Telecommand Execution 
reports from the TFTS System.  The TFTS Communications server must respond 
to each telecommand from with a series of Telecommand Execution Reports 
(TER).  The Handshaking timer is used to ensure that the TFTS-UI has received 
this TER telemetry within three (3) seconds.  If the User Interface does not 
receive a timely response, the message “Handshake TIMEOUT” will appear in 
the TFTS Status field.  
 
The occurrence of either of these timeout exceptions indicates that either the 
connection between TFTS System and the Router has been lost.  Upon 
notification of a timeout exception, these systems should be checked to ensure 
that they are operating normally. 
 

5.1.4 TFTS System Exceptions 

There are three types of TFTS System 
exceptions, each of which indicates a serious 
problem with the TFTS System.  When the User 
Interface receives notification that one of these 
TFTS System exceptions has occurred, an 
exception message like the one shown in Figure 
8 is generated.  This error message contains a 
short description of the TFTS System exception  

Figure 8 Limit Error 
Exception 

as well as TFTS hardware and software status information in the form of two 
hexadecimal 32-bit words.  The TFTS Data ICD (AD03) contains detailed 
explanations of the component bits of the hardware and software status 32-bit 
words.  Table 2 lists the possible TFTS Exceptions and the action(s) that the 
user should take to correct the exception. 

 
TFTS Exception Action 
DPU Counter Error Abort the current scan 
U500 Feedback Error Abort the current scan 
U500 Limit Error 1. Reset Limit; 2. Reset 

Table 2 TFTS Exceptions 
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5.1.5 Socket Exceptions 
Unable to connect to Router 
This type of socket exception indicates that the 
connection between the TFTS-UI and the EGSE 
Router cannot be established.  The user should 
check that the correct IP/PORT Numbers were 
chosen (§2.5) and that the EGSE Router is 
operating normally. 

Figure 9 Socket Exception: 
Unable to connect to Router 

 
Router drops connection 
If the EGSE Router drops the connection to the 
User Interface an exception message as shown in 
Figure 10 will appear.  Select OK to disable the 
socket locally.  The focus of the TFTS-UI will then 
switch to the Initialisation Tab. Figure 10 Socket Exception: 

Router drops connection  

5.1.6 Other Exceptions 
Bad Telecommand 
If the TFTS System receives a poorly formatted command, it will send a 
Telecommand Execution Exception report to the TFTS-UI.  The TFTS-UI will 
notify the user of such an exception by way of an error message as.  The 
possible Telecommand Execution Exception reports and the action(s) that the 
user should take to correct the exception are listed in Table 3. 
 
Telecommand Execution Exception Action 
Illegal APID 
Incomplete Packet/Invalid Length 
Incorrect CRC 
Illegal Packet Type 
Illegal Packet Subtype 
Illegal/Inconsistent Application Data 

Resend the telecommand.  If the 
problem persists, disconnect from the 
EGSE Router and re-initialise the 
TFTS-UI. 

Table 3 Telecommand Execution Exceptions 
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6 TFTS User Interface GUI Layout and Description 

The GUI elements that issue the commands to the TFTS System are divided 
according to their function.  The functions that allow the user to disconnect the 
TFTS-UI and/or exit the program are found under the File menu.  The functions 
that are relevant for normal operations are found on the Operations tab while 
those that concern troubleshooting are located on the Troubleshooting tab.  The 
following sections describe each of these elements in detail.  
 

6.1 File menu 
• Disconnect: This menu item closes the socket connection with the EGSE 

Router.  This function only controls the connection between the TFTS User 
Interface and the EGSE Router and does not affect the status of the TFTS 
System. 

• Quit: Choose this menu item to terminate the TFTS-UI application.  If there is 
an open socket connection, it is closed before the application is terminated. 

 

6.2 Status Panel 
Diagnostic information from the TFTS System is constantly displayed in the lower 
panel of the TFTS User Interface (see Figure 4).  This diagnostic information 
comes from the TFTS housekeeping data and is updated once per second.  
These  parameters are: 
 
• Position: The current absolute position of the TFTS stage.  Measured from 

the top of the table in units of mm. 
• Direction: The current direction of stage movement. 
• Speed: The current speed of the stage in units of mm/s 
• ZPD: The stage position of zero path difference.  Expressed in units of mm, 

measured from the top of the stage. 
• Message Window: The scrollable window contains additional detailed status 

information regarding the TFTS System 
• Help Window:  The lowermost message field in the Status Panel contains a 

description of the TFTS-UI GUI element to which the mouse pointer is 
currently pointing. 

• TFTS Status: See Table 4 for descriptions of the possible TFTS Status 
values. 
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TFTS Status Description 

IDLE The TFTS stage is not currently executing a command and is ready to accept 
a command. 

SCANNING 
The TFTS stage is currently executing a command.  Note that this command is 
not necessarily a Scan but could also be a Reset, Home, Move or a Reset 
Limit command. 

ABORT The TFTS System has executed the Abort function.  A Reset command should 
be issued before issuing any other commands. 

ERROR 
The TFTS System is in an error state.  The user should investigate the error.  
When the error is resolved, a Reset command should be issued before issuing 
any other commands. 

BUSY 
The user has attempted to issue a command while the TFTS System is 
executing another command.  A BUSY status indicates that the second 
command was disregarded by the TFTS System.  

N/A 
The status of the TFTS System is unknown.  This status condition occurs 
when either the TFTS User Interface or the TFTS System (or both) has not 
connected to the EGSE Router. 

Disconnected The User Interface has severed its connection to the router.  The TFTS 
System may or may not be connected to the Router. 

Handshake 
TIMEOUT 

The TFTS User Interface issued a command to the TFTS System but did not 
receive the expected response within the appropriate period (see §5.1.3). 

Heartbeat 
TIMEOUT 

The TFTS User Interface has stopped receiving Housekeeping information 
from the TFTS System (see §5.1.3). 

Table 4 TFTS Status States 

6.3 Initialisation 
The Initialisation Tab of the TFTS User Interface item is used to open a socket 
connection with the EGSE Router.  Both at start-up and after the connection to 
the EGSE Router has been disabled, the Initialisation Tab is the only TFTS-UI 
tab that is active.  When a connection between the TFTS-UI the EGSE Router is 
established, the Initialisation tab is de-activated and the other TFTS-UI tabs 
become active.  
 
Data Entry Fields 
• Host Name: This drop down menu contains a list of pre-defined hosts on 

which the EGSE Router has run.  Selecting one of the items in this menu will 
populate the IP and Port fields associated with that host name.  This field may 
be edited to allow the user to store a new EGSE Router host name. 

• IP:  The IP address of the host on which the EGSE Router is running. 
• Port: The port number on which the EGSE Router is listening for new 

connections. 
Buttons 
• Store Router: If the host on which the EGSE Router is running is not listed in 

the Host Name menu, select this button to store its name, IP address and 
Port number for future use.  
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• Connect: Select this button to attempt to establish a connection with an 

EGSE Router running on a host whose IP address and Port numbers are 
given by the values in those data entry fields. 

 

6.4 Operations 
The elements on the Operations Tab are those that are used when operating the 
TFTS System in scan mode. 
  
Data Entry Fields 
• Title: The user-specified title of the current scan. The user may enter a title or 

may choose from a list of the five most recent titles. 
• Comments:  The Comment field stores additional information about the 

current scan.  The user may enter a comment or may choose from a list of the 
five most recent comments. 

• Resolution: The desired resolution for the current scan in units of cm-1.  The 
value in this field is limited to four decimal places and must be in the range 
given by: 

 
Resolution Range = [Highest Resolution, Lowest Resolution]. 

 
where: 

( )( )






−×

=
ZPDcm

ResolutionHighest
204

21.1  

( )






×

=
ZPD

ResolutionLowest
4

21.1  

 
• Sampling Interval: The desired sampling interval for the current scan in units 

of µm.  This is a floating-point parameter with no decimal places. 
• Nyquist Value: This is a read-only parameter whose value is calculated 

based on the value in the Sampling Interval field.  The Nyquist Value is 
evaluated as: 

( )IntervalSampling
ValueNyquist

×
×

=
4

101 5

 

 
The Nyquist Value is presented in units of cm-1 and is limited to two decimal 
places. 

• Scan Speed: The desired speed for the current scan.  This value is 
presented to two decimal places in units of mm/s. 

• Iterations: The number of iterations desired for the upcoming scan. 
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Parameter Default Value Range Units 
Title N/A < 20 characters N/A 
Comment N/A < 60 characters N/A 
Resolution* 0.0168 0.0168 — 0.1513 cm-1 
Sampling Interval 25 10 — 100 µm 
Scan Speed 5 1 — 55 mm/s 
Iterations 10 1 — 999 N/A 
Acceleration 1000 10 — 2500 mm/s2 

*Resolution values shown are based on a ZPD = 2.0mm 
 
Buttons 
• Set Defaults: Press this button to populate the scan parameter fields with 

default values. 
• Halt: Abort the current scan sequence immediately.  Press this button to 

issue an Abort command to the TFTS.  The result is that the current scan 
terminates immediately and all science data for the current scan is sent to the 
EGSE Router.  Furthermore, the TFTS System will enter the ABORT state.  
Note that the Abort command may be issued even if the TFTS is not 
scanning. 

• Truncate: Stop the current scan sequence gracefully.  Press this button to 
issue a Truncate command to the TFTS System.  The scan sequence will 
terminate after the current scan is complete.  Issuing the Truncate command 
when there is only one scan remaining in the sequence has no effect on the 
TFTS System. 

• Scan: Begin a scan sequence.  Press this button to issue a Scan command 
to the TFTS System.  The parameters of the Scan command are determined 
from the values entered in the scan parameter fields (see Figure 5).  If the 
values in any of the fields are outside their accepted range, the SPIRE User 
Interface will issue an error message to the user informing the user of the out-
of-limit condition (§5.1.1). 
 

Diagnostic Parameters 
• Current scan:  The current scan information from the housekeeping data.  

Here, current scan number and the total number of iterations are displayed. 
• Estimated Time to Complete: This read-only parameter is calculated based 

on the TFTS housekeeping data.  The estimated time to complete is 
calculated as follows: 

 

v
ddHalfScans#completetotimeEstimated rem+×

=  

where 
• HalfScans#  is the number of up scans and down scans remaining in 

the requested scan sequence 
• d is stage displacement required for a HalfScan  
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• remd is the distance required to complete the current HalfScan  
• v is the current stage speed 

  
• Scan Limits: The values in these two fields represent the absolute stage 

positions of the limits of the currents scan in units of mm. 

6.5 Troubleshooting 
The purpose of the elements of the Troubleshooting Tab is primarily to issue 
commands to the TFTS System to allow it to recover from and error condition.  In 
addition, the elements on the Troubleshooting Tab are used for verification of the 
position of zero path difference for the TFTS System.  

6.5.1 Reset Panel 
The reset panel contains three buttons representing three reset levels for the 
TFTS System.  These reset levels are: 
 
1. Reset Unidex 500 card 
2. Move stage to calibration position 
3. Move stage to a specific position 
 
The buttons in the reset panel perform the following actions: 

Button Action 
Go 3 
Home 2, 3 
Reset 1, 2, 3 

6.5.2 Jog Panel 
The elements in the Jog panel allow the user to move the stage a specified 
distance and direction at a specified speed. 
 
Buttons 
• Move Stage: The two arrows (pointed up and down) are used to specify the 

direction of the desired stage movement.  The distance and speed for the 
requested move are given by the values in the data entry fields. 

• Move About ZPD: Press this button to cause the TFTS stage to move in a 
periodic fashion from its current position.  The stage will move about the initial 
stage position with an amplitude given by the value in the Distance data entry 
field (see below).  This periodic motion continues until a Halt is issued. 
 

Data Entry Fields 
• Distance: Enter the desired move distance in mm in this field.  This field is 

also used to specify the length of the loop when scanning about ZPD. 
• Speed: Enter the desired speed for the move commands in this field. 
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6.5.3 Remaining Troubleshooting Elements 
• Connect Test: Select this button to issue a Connect Test command to the 

TFTS System.  This type of command is useful for determining whether the 
TFTS System is still active and able to respond. 

• Reset After Limit Error:  The user should only press this button if one of the 
stage limits has been breached.  The user will be notified of such a condition 
via a TFTS User Interface exception report (§5.1.4). 

• Halt: See above (§6.4). 
• Store ZPD: During verification, it is necessary to locate the stage position 

corresponding to zero optical path difference (ZPD).  When one is confident 
that the stage is at the ZPD position, press this button to generate a pop-up 
window that will ask if the user wishes to store the position of the stage.  
Answering in the affirmative stores the ZPD value as a permanent variable. 

6.6 Other TCs 
This TFTS-UI tab contains buttons that issue those commands to the TFTS 
System that are not critical to Initialisation, Operations or Troubleshooting. 
 
Buttons 
• Set OBSID: Enter an Observation ID in the associated data entry field and 

select this button to command the TFTS System to set the Observation ID to 
this value.  The Observation ID value is restricted to integers in the range 0 – 
65535.    

• Set BBID: Enter a Building Block ID in the associated data entry field and 
select this button to command the TFTS System to set the Building Block ID 
to this value.  The Building Block ID value is restricted to integers in the range 
0 – 65535. 

• Set Parameter: Select this button to write the value as displayed in the 
associated data entry field to the U500 parameter as selected with the 
associated drop down menu.  Refer to RD02 for a list of the available 
parameters and their ranges.  

• View Parameter: Select this button to read the value of the U500 parameter 
given by the value in the associated drop down menu.  Refer to RD02 for a 
list of the available parameters.  The value of the chosen U500 parameter is 
displayed in the associated data entry field. 

 
Data Entry Field 
Acceleration: Edit this field to select the acceleration of the TFTS Stage in units 
of mm/s2.  This field is used to select the desired acceleration for both the 
Scanning (§6.4) and Moving (§6.5.2) commands. 
 
NOTE: It is recommended that the value in the acceleration field not be 
changed. 




